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WELCOME TO THE WORLD OF
LEGO® MINDSTORMS®

Congratulations onyour new LEGO® MINDSTORMS® NXT robotics tool set. You
now have the power to build and program robots that do what you want!

ODream if, build it

Your MINDSTORMS NXT sef enables you to create thousands
of rohotic inventions. Intelligent robots that see, hear,
speak, feel and move. Advanced robots that you can confrol
with your mobile phone. Loal robots that quard your room
and do your chores. IF you can dream if, you can build it.

Build. Program. Go!

Creating a MINOSTORMS rohaot is easy. Build the robot using

your LEGD elements. Program it using the easy-to-use soft-
ware and watch your robot come alive. Foryour Airst robotic
adventure, try out the quick-build model that you can build

and program in less than 30 minutes.

Smart technologies

Your MINDSTORMS NXT set features the latest in robotic technology: an
advanced 3¢-bit programmable microcontroller; icon-based drag and drop
programming software and interactive challenges; smart sensors and Inter-
active Servo Motors; wireless Bluetooth and US5B connection. In fact all the
smart technologies you need to create your dream robot.

MINDSTORMS.com

You are now a part of the worldwide LEGD MINOSTORMS community. Log on
to MINDSTORMS.com and get more robotic challenges. Download programs,
sound effects and other cool stuff. Share your inventions and exchange fips
and tricks with other MINDSTORMS users. www . MINOSTORMS.com is your new
rohotic hot spof.

Find out more
!¢ Inthis User Guide you can learn more about the technology
T, and the many exciting features in your MINDSTORMS set,

Have fun building your own amazing robots!

The LEGO MINDSTORMS team.
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_J INTRODUCTION

BUILD. PROGRAM. GO!
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Build
Build a robot. You can And building
instructions in this User Guide, in the
software or at www.MINOSTORMS.com.
Oryou can use your imagination fo
build your own unique robot,

Program

Program your robot to do what you
want. Llse the LEGO® MINDSTORMS® NXT

Software to make a program. Download

the program to the NXT by using the
LI5B cahle or the wireless Bluetooth

connection.
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|| Quick Start

| Use the Quick Start kit to get your Arst
MINOSTORMS experience. In the Quick
Start kit you will And everything you
need to get off fo a great start. It will
only take you a few minutes to create
your Arst MINOSTORMS robaot, test if,
and get a fun reaction.

Go!
Run the program and watch your robot
came to life,
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NXT TECHNOLOGY OVERVIEW
The NXT

The NXT is an intelligent, computer-controlled
LEGO® brick and the brain of the MINDSTORMS® robot.

”’_‘,—*2] Touch Sensor

Enahles the robot to Feel and react to

its environment.

L

/) Sound Sensor

Enahles the robot to hear and react to
sount.

—
Gy Enables the robot o detect lightand
color.

__,b@' Light Sensor
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G Lltrasonic Sensor

Enables the robot to see, measure
distance to an ohject, and react to
movement.

Ensure that the robot moves with precision.

& % Interactive Servo Motors

Standard port settings for sensors

and motors
To makeyour rohot work correctly, the sensors and
motors should be connected to specific input and out-
put ports. Here are the standard port settings:

Input ports

Port 1: Touch Sensor
Port 2: Sound Sensor
Port 3: Light Sensor
Port 4: Ultrasonic Sensor

Output ports

Port A: Motor used For an extra function
Port B: Motor for movement

Port C: Motor For movement

~
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CONNECTING THE NXT TECHNOLOGY

Note that ALL of the black b-wire |
cables can be used in both input
and outpuf porfs, sensors and

= g‘“ f motors. To work, sensors MUST be
e attached to the input ports [1-4
: and motors MUST be attached fo
4 the output ports [A-L].

Lonnecting motors
To connect a motor to the NXT, use one of the black b-wire
cables. Attach one end of the cable to the motor and the other to

one of the NXT's output ports |A, B, or ).

Connecting sensors

Toconnect a sensor to the NXT, use one of the black b-wire
cahles. Attach one end of the cable fo the sensor and the other
to one of the NXT's input ports |1, €, 3, or 4.

Downloading and uploading

The 5B port and wireless Bluetooth connection let you download and
upload data between your computer and the NXT. IF yvour computer has
Bluetooth capability, you can download programs to the NXT without using
the L5B cable. If your computer does not have Bluetooth capahility, you
must use the USB cahle or install a Bluetooth USE dongle onyour computer.
NOTE: Read more ahout wireless Bluetooth communication on page £8.
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Make sure that the
LEGD® MINDSTORMS® NXT
Coftware is installed before

i

| connecting your NXT to your PL
‘b‘ |see page 3B).

]

1)
Turn on the NXT.
—l | i

- Connecting the NXT to a PCwith a USB cahle
e
s

r'
T

LConnect the PL and the NXT with the USE cahle.

when the PLidentifes the NXT it will automatically Analize the
installation of the LEGO MINOSTORMS NXT Software.

The USB connection must be made by an adult or under
supervision of an adult.

jr,.ﬂ Found Mew Hardware jr,) Found Mew Hardware

LEGD MIMDSTORMS MET Your new hardware is installed and ready ko use,

Connecting the NXT to a Macintosh with a USB cable

Make sure that the LEGO MINDSTORMS NXT Software is installed before connecting your NAT to
your Macintosh |see page 39].

Turn on your NXT.

Lonnect the USB cable to the NXT.

Lonnect the USE cable fo the Macintosh and you're ready to go.
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ABOUT THE NXT

The NXT is the brain of a MINDSTORMS® robot. It's an infelligent,
computer-controlled LEGO® brick that lets a MINOSTORMS robot come
alive and perform different operations.

Please note that all text on the NXT display is in English.

Motors ports

The WXT has three output ports for attaching &
motors. Ta make the motor work, the maotors

need to be attached to port A, Bar C

Bluetooth icon

The Bluetooth icon shows the current status of

any wireless Bluetooth connections. IF there is no N
Bluetooth icon shown, Bluetoath is OFF.

*

Bluetooth is ON butyour NXT is not visible to
other Bluetooth devices.

- 14

Eluetooth is ON andyour NXT isvisible to other
Eluetooth devices.

e

Bluetooth is ON andyour NXT is connected foa
Bluetooth device.

LI5SB icon
When you connect your NXT to a computer with b=
a LISE cable, a USB icon will be displayed. |Fyou

disconnect the USE cable, the icon will disappear. T

USE connected and working Ane.

-y ™
USE connected but not working properly.

LI5B port

Connect a USE cahle to the USE port and down-
load programs fromyour computer to the NXT [or
upload data From the robat to your computer],
You can also use the wireless Bluetooth connec-
tion For uploading and downloading.

k.

Sensor ports

8

The NXT has four input ports for attaching sen-
sors. The sensors need fo be attached to port 1,

¢, 3ord,

|
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i Naming the NXT P il
You can change the name of your NXT by going to - N
the NXT window in the software. This window is oy 2 '
accessible from the Controller. NXT names can be g e J— |
at most eight characters long. ] — :
_."_H_F:
4 1  Batterylevel
The battery icon displays the power level of the
MXT. When battery poweris low, the battery icon
will Flash on and off.
Technical specifications
« 32-hit ARMT microcontroller
4 [ =1 Runningicon - _ « 256 Khytes FLASH, b4 Khytes RAM
when your NXT is turned on, the running icon will + B:bit AVR micr Villie
spin. [Fthe running ican stops spinning, your NXT r AP T o
has frozen and you will need to reset it [see page * 4 Khytes FLASH, 512 Byte RAM
74, Troubleshooting. » Bluetooth wireless communication [Bluetooth Class 11
Ve 0 compliant]
B Loudspeaker . LIEI|H full speed |IIIIII'I1' [1¢ H|]i1'f:5]l
Make a program with real sounds and listen to « dinput ports, b-wire cable digital platform [One port
them whenyou run the program. includes a IEC 61158 Type 4/EN 50 170 compliant
expansion port for future use
« 1 output ports, b-wire cable digital platform
$&  NXT buttons « 100 % b4 pixel LLO graphical display
Orange buttan: On/Enter » Loudspeaker - 8 kHz sound quality. Sound channel with
Light grey arrows: Used For moving left and right B-bit resolution and 2-16 KHz sample rate.
in the NXT menu. ) . 3
Dark grey button: Clear/bo back » Power source: b AA batteries
e Turning off your NXT -
Push the dark grey button repeatedly until you MeT o
see the screen on the right. 3 B
Push the arange button to turn off your NXT;
push the dark grey buttan to go back to the main TUrm .:,H: F

MenLl.

NXT display options

Your NXT has many other cool features. Read
maore about them on the following pages.

1
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INSTALLING BATTERIES IN YOUR NXT

Battery type
« The NXT requires b AA/LRE batteries to function properly.

» Alkaline batteries are recommended.
« Rechargeahle batteries can be used, but the NXT's power
may be reduced, making the motors furn more slowly.

d -t

] e
T I""-r_fz :‘rrf-l "

a

&

‘ Low battery power
When battery power is low, this iconwill pop up on the
NXT's display screen.

Important information about batteries
Never use different types of hatteries fogether, or a
combination of old and new hatteries. Always remove
the hatteries if the product is not to be used for a long
fime ar if the batteries have run down. Never use

/ damaged batteries. Only use batteries of the type
J recommended, or a corresponding fype. Insert the
batteries so that the poles are correctly positioned.
Rechargeable batteries must be recharged using the
correct battery charger under the supervision of an

1 5 LR 6 (AA) adult. You cannot recharge batteries while they are still
&

-

1:1 in the product, and you must never try fo do so.
Never aftempt to recharge non-rechargeahle hatteries.
Never short-circuit the battery holder.

|
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NXT MAIN MENU
My Files

The My Files submenu will let you see all of the programs you
have made on the NXT or downloaded from your computer.

Softvare il es MNATFiles
‘IE\ Eiy
(n m
Software hles - programs you NXT fles - programs you have
have downloaded from your macde on the NXT
computer

Files will automatically be placed in the appropriate subfolders. When you
download a program including a sound Ale to your NXT, the program will be
placed under Software fles, while the sound data will be placed under Sound
fRles. You can send fAles to other NXTs. Read more about this on page 36.

Sound Fil es

Sound Ales

13
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NXT Program
R v

You don't need a computer to program your robot. Using
the NXT Program submenu, you can make thousands of
different programs without your computer.

Try this simple program and see how easy if is:

Make the robot go hack and forth when its Touch Sensor is pressed.
First, the robot will move forward until the Touch Sensor is pressed,
and then it will move backwards. When its Touch 5ensor is pressed
again, the rohot will move forward once again. This will continue
indefnitely until you stop the program.

Make sure that your sensors and motors are connected to the right
ports.

2. PR——_— 3 R T— L

; |
T.J - ‘T._r
T e, | T
- 1/ =

. I,J
h ; J |

Select Farward. Use the amow buttons Select Touch. Select Backward.

to maove through the choices and then

press the orange hutton [Enter| to

make your selection.

E
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Select Touch again. Mow select if you want the program to Mow you can run your progranm.
Loop. This means that the program will Simply select Run!
run again and again until you switch
off the NXT. For our little test, select
Loop.

Try these programs as well:

"IfTHAH rHAHD

I HkH ol
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Try Me

The Try Me submenu lets you test your sensars and motors

in a fun way:

|

Lonnect the sensors and motors to the appropriate ports on
the NXT. Important: Use the standard settings for the ports as
explained on page 7.

Select a program.

When you press the orange |Enter| hutton, you will get some
fun reactions From the sensors and motors.

Explore ather Try Me programs to get some more fun sounds, to
display images and to experience different motor reactions.

You can always delete these Try Me files again using the
Settings submenu.
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View

The View submenu lets you carry out a quick fest of your
sensors and motors, obhserving real-time data from each
unit:

Lonnect the sensor ar motor you would like to test o
the NXT - the View submenu will help you select the

right port or check standard settings on page 7.
Select View on the NXT's display.

1

|
L I-I. L 'll.
el el M TTE
[ / = E/ = /
{ i ) l Al | ,
Select the icon of the sensor or motor Select the port that the sensoror mo- The data from the sensor ar mator will
you would like to fest. You can only get toris atfached to. appear on the display.

readings from one sensor or motor at
a time.
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Settings

The Settings submenu lets you adjust the NXT's settings
including its speaker volume or the Sleep mode setting.
This submenu will also let you delete programs that have

heen stored in the NXT's memory.

*

T
-

oo bl

F
e

Change volume:

Here you can adjust the volume

of the NXT's speakers.

|

Gleep mode: You can set the NXT to furn

itself off after ¢, 5, 10, 30 or b0 minutes of
inactivity [time when its not inuse|. You can also
select the Never setting so that it remains on
indefnitely [until you turn it off|. Please he aware
that the Never setting will drain your batteries more

quickly.

r

.
*

dEb
[

bl

L

Delete all programs:
You are able to delete all downloaded pro-

grams in the 3 sub folders: Software fAles,
NXT fAles, Sound Ales, from the Settings
submenu.
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Bluetooth
et e

The Bluetooth submenu will let you make a wireless
connection between your NXT and other Bluetooth devices
|like other NXTs, mohile phones, and computers|. You can use
a wireless Bluetooth connection to send programs to other
NXTs, to download programs from your own computer
without using a USE cable, and lofs of ofher cool things,
such as using your mobile phone to control your robot! Read
more about wireless Bluetooth communications on pages £8.

13
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My Fil es
B
My Files
|
Sound Files Software Files Ml files
= =
Saund Ales Saftware Ales NXT Rles

Fort 1: Touch Sensar
Fort £: Sound Sensor
Fort 3: Light Sensar

Fort 4: Ultrasonic Sensor

Fort B/C: 'R motors

MAT Prograrn
oo |
u.ﬂ

MAT Program

Flease use pork:
1 - Tauch Sensor
2 -Sound  Sensor
5 - Light Sensor
3 - by asonic

E/C - LIR motors

Forweard 5
Ncil

1
Forward 5

5

E’m_ﬂ

Empty

F

Eack left Turn left Turn left z Empt Backyvard Backward 5
H H
|¢£I | “ “ Il ‘ Il \
Back left Turn left Turn left £ Empty Backward Backward 5
Back left 2 Tane & Tome 1 Back right Eack right 2 Turn right
e ] | o o @
Back left £ Tone £ Tone 1 Back right Back right 2 Turn right
Forward Turn right 2
‘ ] @]
Forward Tum right £
Sond Light | Touch |
2] O] =]
Sound Light Touch
Cbjeck wiait 10 Wait & WWaik £
FIE
|| LE] Z| Z|
Ohject Wait 10 Wait § Wait 2
[ A Loop
General lcons: )
A File exsists Filename:
‘ Save \ W‘?ﬁ'”m? Unkitled_ Loop
‘ . | ]
D E:’F7 ’% 321 f:'f abe
Run Save File exists. Overwrite? File name: Untitled
Send Celete Main menu
|#E| [ &, Sending Fi"?} | i \ Lh ‘ fo File sawed}
Sent Sending fle Oelete Main menu File saved

i

|

Stop
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Views

View

Eluekooth

Bluetooth

Sound dE Sound dBA Reflecked light
A2 Ed Z _[®
Sound df Sound dBA Reflected light Ambient light
Termmperature F* Temperature Ligh t Sensor
5 Ae
Temperature F* Temperature [* Light Sensor*
Rokation® Mokor Fokations Mokar deqgrees
0 = & ‘
Roftation® Maotor rotations Motor degrees
Lltrasonic cm Ulerasonic inch Touch
& o
Lfrasonic cm Ultrasonic inch Tauch
Seleck

Fork 1

Port 12,3, 4, 4,8, C

Ambient i ght

Visabilicy
& |

Visibility

“Wisible
=
]

Visible

Invisible
—

lvisible

[y cank acks

My contacts

Settings

2

Settings

Wil e

<]}

Yolume

Try Me

Try Me

Sleep ]_‘DEJE:':E: Fi |E=5‘
S

Oelete Ales

Deleting & |
i | esl
Are you sure?

of |

Deleting all Ales!
Areyou sure?

Sleep

Conneckions

ey

Connections

oy

r

On

Off

OFf

[E Searching]

Searching

| % Turning -:|n|

Turning on

|ﬂ, Failed !]

Failed!

| %% Conneching |

Connecting

| A Connection |

Connection?

[ A Line is husrl

Line is husy

¢l
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3 TOUCH SENSOR

The Touch 5ensor gives your rohot a sense of touch.
The Touch Sensor detects when it is being pressed by
something and when it is released again.

v ™ i ™ ' ™y

G0 G0 G

Pressed Released Bumped

| Suggestions for use

You can use the Touch Sensor to make your robot pick up
things: a robotic arm equipped with a Touch Sensor lets the
rohot know whether or not there is something in its arm to
grab. Oryou can use a Touch Sensor to make your robot act on
a command. For example, by pressing the Touch Sensoryou can
make your rohot walk, talk, close a door, or turn on your TV,

Trv Me  Test it

‘ \ Test the Touch Sensor and get a fun reaction.

E] Connect a Touch Sensor to port 1 of your NXT and
select the Try-Touch program in the Try Me submenu
on the NXT's display.

|
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f SOUND SENSOR

The Sound Sensor makes your robot hear!

The Sound Sensor can detect hoth decibels [dB| and
adjusted decibels |dBA]. A decibel is a measurement of
sound pressure.

dBA: In detecting adjusted decibels, the sensitivity of )
the sensor is adapted fo the sensitivity of the human

ear. In other words, these are sounds that yvour ears are )))
able to hear.

dB: In detecting standard [unadjusted|] decibels, all J
sounds are measured with equal sensitivity. Thus, these

sounds may include some that are foo high or low for the human ear to hear.

The Sound Sensor can measure sound pressure levels up to 90 dB - about the level

of a lawnmower. Sound pressure levels are extremely complicated, so the Sound
Sensor readings on the MINDSTORMS® NXT are displayed in percent [%]. To give some
comparative examples: 4-5% is like a silent living room. 5-10% would he the reading
you get from someone talking some distance away. 10-30 % is normal conversation
close to the sensor or music played at a normal level. And you will record readings of
30-100% from people shouting and music played at high volumes.,

Test it!

Test the Sound Sensor's ahility to read
sound volume:;
Lonnect the Sound Sensor to the NXT.

Suggestions for use

You can use the Sound Sensor to make
a sound confrolled robot. Talk to your
robot and it will answer you back. Llap
your hands and the robot can pick up
things and bring them to you.

1

-

Select the View submenu on the Make some sounds info the Sound Sensorand watch the readings
NAT's display. Select the Sound displayed on the NXT. LIse the sensor to read some sounds around you.
Sensoricon and the port where you How loud dovyour parents speak? How loud isyour front doorhell?

have connected the sensaor.

Select the Try Me submenu on the NXT's display and test
vour Sound Sensor. You'll get a fun reaction.

£3
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< 0
< J LIGHT SENSOR

The Light Sensor is one of the two sensors that give
your robot vision [the Ultrasonic Sensor is the aother].
The Light Sensor enahles your robot to distinguish
between light and dark. It can read the light intensity
in a room and measure the light infensity of colored

surfaces.
r.. | This is what yaur eyes see.
-. This is what your robot will see,
using the light sensaor.
L. -

Suggestions For use

You can use the Light Sensor to make a burglar
alarm robot: when an intruder turns on the light
inyour room, the robot can react to defend your
property. You can also use the Light Sensor fo
make a line-following robot or a robot that can
/ sort things by color,

Detecting ambient [surrounding] light

Test the Light Sensor's ability fo read ambient light by
measuring the light level in different locations of the room.
For example, first hold the sensor against the window. Then
hold it under the table. Watch how the readings differ.

Test if! J
You can test the Light Sensor in different ways:
Connect the Light Sensor fo the NXT.

. [——T |

i s g

kil (=
- e ‘.-" L_ _‘-"
Select the Yiew submenu on the Hald the Light Sensor up to the different colors on the test pad and see
NAT's display. Select the Light the different readings.

Sensor ican and the port where you
have connected the sensor.

E

Select the Try Me submenu on the NXT's display and test your
Light Sensar. You'll get a fun reaction.
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1&@ ULTRASONIC SENSOR

The Ultrasonic 5ensor is the other sensaor that gives
your robot vision. The Ultrasonic Sensor enables the
robot to see and defect objects. You can also use it to
make your robot avoid ohstacles, sense and measure
distance, and defect movement.

The Ultrasonic Sensor measures distance in
cenfimeters and in inches on the NXT. It is able to
measure distances from 0 fo 255 centimeters with a
precision of +/-3 cm. "

The Ultrasonic Sensor uses the same scienfific principle as bats: it measures
distance by calculating the time it takes for a sound wave to hit an object and return
— just like an echo.

Large-sized ohjects with hard surfaces return the best readings. Objects made of

soft fabric or that are curved [like a ball] or are very thin or small can be difficult for
the sensor fo defect.

Note that two or more Ultrasonic Sensors operating in the same room may interfere
with each other's readings.

Test it!

Test the Ultrasonic Sensor's ahility fo measure distance:
Connect the Ultrasonic Sensor fo the NXT.
Select the View submenu in the NXT display.

g —=

Suggestions for use

You can use the Ultrasonic Sensor in
many different ways. Program a rohot to
sneak around the house without it
bumping into things. Or make an
advanced hurglar alarm robot that react:
fo movement as well as light. Your
Scorpion rohot “stings” if you come to
close.

h

|
2

4 3 b
=

S e ) 2) 3 (P———

b D

— -~

Select the Ultrasonic Sensor icon Measure the distance to an abject. For example, move your hand closer to

and the port where you've con- the sensor and watch the readings change.
nected the sensar.

Select the Try Me submenu on the NXT's display and test your
Ultrasonic Sensor. You'll get a fun reaction.

25
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INTERACTIVE SERVO MOTORS

The three Servo Motors give your robot the ability
to move. If you use the Move block in the

soffware to program your mofors, the fwo motors
will automatically synchronize, so that your robot
will move in a straight line.

Built-in Rotation Sensor

Each motor has a built-in Rotation Sensor. This lets
you control your robot's movements precisely. The
Rotation Sensor measures motor rotations in degrees
or full rofations |accuracy of +/- one degree|.

One rotation is equal o 360 deqgrees, soif you sef a
motaor to turn 180 degrees, its output shaft will make
half a turn.

The built-in Rotation Sensor in each
motor also lets you set different speeds
For your motors |by setting different
power parameters in the soffware|. Try
running the motors at different speeds.

Test it!

Test the built-in Rotation Sensor's ability to measure distance:
Lonnect a motor fo the NXT.
Select the View submenu in the NXT's display.

qmb
-

select the Motor Rotations icon. Now attach a wheel to the motor and measure the rotations as you roll the wheel along the floor,
Select the port where you have

LONAEEEL e muir, Select the Try Me submenu on the NXT's display and test your

motors. You'll get a Fun reaction.

|



_| NXT TECHNOLOGY

=l 1. The motor

=) 2. Tachometer [Rotation Sensor|

ke

3. Built=in gearing

]
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€3 Bluetooth’ usinG sLucrooTh

- 51

" 1

o

Bluetooth is a technology that makes it IFyou have a mohile phone with Bluetooth
possible to send and receive data without capability, you can use it fo control your
using wires or cables. Using Bluetooth, robotf. You might even be able fo use it as
you can exchange programs hetween your an advanced sensor, like a camera sensor.
NXT and other NXTs. Or yvou can establish Visit www . MINDSTORMS.com/bluetooth, far
a wireless connection hetween your com- more information on mobile phone require-
puter and your rohot and try out programs ments.

instantly — even with your rohot on the
other side of the room!

|
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CONNECTING YOUR NXT TO A COMPUTER

Before you try to sef up a wireless Bluetooth connection, make sure
that your computer has Bluetooth capability.

If vour computer does not have huilt-in Bluetooth capability, you
must use a Bluetooth USB dongle. Make sure that you use the right
fype of Bluetooth USH dongle. Read more ahout the different types of
Bluetooth USE dongles to use at www.MINOSTORMS.com/hluetooth

. 5
1) MXT windowm |

g Wl
Make sure thatyour NXT is turned on. Also Find the Controller at the lower right corner
make sure that yvou have Bluetooth set to of the work area in the software. Click on the
On and that your NXT is sef to he Visible MXT window hutton [the one at the upper left]
[read how in the Bluetooth submenu on and the NXT window will open.

the NXT on page 14]. Also make sure that
Bluetooth is installed and enabled on your
computer, See yvour computer's and
Bluetooth USB dongle's instruction manu-
als for details.
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Click Scan. Your computer will automatically search far
Bluetooth devices.
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i ~ After a short interval, a list of availahle Bluetooth devices
2 ‘ will appear in the window on the computer screen. Select
the device you want to connect to and click the Connect
Ml ir -
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this device [the default passkey is 1234 and click OK.
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n
45 .
- »

=

£ prr— ) ‘ Enter the passkey on your NXT and confirm the connection
- by pushing the arange [Enter] buttan. IF you have chosen

-‘- the default passkey, just click the orange |Enter] button,
S— . "

Mail

\ In the NXT window, the status of your NXT has now changed
from Available to Connected. Your NXT and computer are
now connected and can share data.

Hama | Conrwerion Trra | Stams

coneet || Remove [ zn ]

I oo T raey Y o oa
|.

ol P oerE MIT 51

Marve: [HH‘I’

.':J.

L [Change name of cur

A2 Een P 07 £

Frms Sharsgm: 443 KB

FHT/NEME UaEDn]

H

D4

+:.

Make sure that your NXT is furned on. Also
make sure that you have Bluetooth set to
On and that your NXT is set to be Visihle
[read how inthe Bluetooth submenu on
the NXT on page 14]. Also make sure that

Bluetooth is installed and enabled on your

computer, See your computer's and
Bluetooth USB dongle's instruction manu-
als for details,

o

Find the Lontroller at the lower right corner
of the work area in the software. Click on the
NXT window hutton [the one at the upper left|
and the NXT window will open.
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Click Scan. The Bluetooth device window will pop up on the
sCreen,

4 list of Bluetooth devices will appear in the Select
Bluetooth Device window on the screen. Select the device
you want to connect to and click the Select button.

The NXT that you want to connect to appears in the NXT
window as available. Click the Connect button,
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b " LECO MINDETORMS NXT
| - T
O e
e
Pair with a Bluatooth Device
Select 2 Bluptzath Dewice and click the Pair buttan.
To find devices in fnge of wour compuler 10 pair with, cligk the Saangh
bustran, I weur device 15 not found make sure IE s “disooveraie” and
search again.
Chow only Al Devices il
Clevice Category:  All Categories e I
1 Device e
' f
J i
]
{ Search Again | | Cancel {  Pair ) ﬁ
r

7] CO MINDSTORMS MXT

Please anter 3 Passkey To Lse with this device

;‘ Fazs ks arg radquired 1o gair «ith o Bleetgoth gevice, The same
passhey must be entered an the dewice as well as this compater.
Most devices allow you to create wour awn Passkey, but some
pevices require a fieed one,

MET
1334

1 Bevics Cancel [ oK -]I

|

Cisooveriing Blustonth Davices |

| Search Again | | Cancel

Barnch |
ind

Pair ) ﬂ

=

2 [

S Ik

-

(

. Eﬁ‘.

- |
-
a

Enter the passkey onyour NXT and confirm the
connection by pushing the orange [Enter] button. IF
vou have chosen the default passkey, just click the
orange [Enter| button,

The Pair with a Bluetooth Device window pops up.
Select the NXT. Click Pair.

whenvyou connect to a device For the frst time, a Passkey
window will pop up. Enter the passkey to use with this
device |[the default passkey is 1234] and click DK.

o T -

o cuent HAT 1

aren: [HHT

! et}

Your Macintosh and NXT are now connected and can share data.
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BLUETOOTH SUBMENU ON NXT

X 1 L
| 3 il 3
aE» | 4
- i -

g A ~ - Fi
Bluetooth Cearch

Select the Bluetooth submenuon the

NAT display.

devices that it canconnect to.

1

PR,
._JJ

My Contacts

foucan see all of your trusted Bluetooth contacts
in My Contacts. These contacts can automatically
connect and send data to your NXT without using a
passkey. To add a new confact to the list, you must
have been connected to the contact befare. Oevices

which you have heen connected o, will automatically
be added to the listin My Contacts.

a

bkl

.,

4Eb

ke hidogg

’

LConnections

\

Search For other Bluetooth devices. After yvou have chosen the Search
icon, your NXT will automatically start to search for ather Bluetooth

J

——e

This item displays your current connections. You can
connect your NXT to three devices at the same fime
|on Line 1, 2 and 3|, while one device can connect fo
you [on Line 0]. Note, hawever, that while you can
be “connected” to up to three devices, you can only
‘communicate” with one device at a time.
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|
[ cormmiciin: 1 tHeower I < o
Tour curmenl HET ic:
Ham | Comnmmchon Twaos | Skalur | J
L ] Marngr  [MKT
o et
e |Charge nan= of o
Connacton : I:_.|
Free Shorage: B3 KB
FiTres ars s ont oA
| Conineicl I Remiog ] I Scan | [ olosa
L |

Tou can alsoview the connection status in the NXT window in the
soffware. There you can change the name of your NXT, check
battery and memary levels, and delete programs onyour NXT.

Check the connection status in the icon bar at the top of

the NXT's display.
IFthere is no Bluetooth icon shown, Bluetooth is OFF.

:# EBluetooth is ON but your NXT is not visible
to other Bluetooth devices.

:#{ Bluetooth is ON andyour NXT is visible to
other Bluetaoth devices.

:#{}_ Bluetooth is ON andyour NXT is connected
to @ Bluetooth device.

L -pl a
s /
Visibility Passkey
Use the Visible option to make your NXT The Passkey ensures that only Bluetooth
visible orinvisible to other Bluetooth tlevices approved by you can connect to
devices when they do a Bluetooth search. your NXT, Whenever you connect foa

Bluetooth device for the Arst time using
vour NAT, youwill he asked fora passkey.
Select the preset passkey 1234 or make up
your own code. Other Bluetooth devices
must know your passkey in order to confArm
a connection with your NXT.

ST -

4Eb
s

On/OFF

You can turn Bluetooth functionality on
or off, [Fyou furn Bluetooth off, you will
not be able to send or receive data over
Bluetoaoth. Ta save battery power, turn
off the Bluetooth function when it is nof
in use.

Nate! Bluetooth is furned off by default.
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CONNECTING YOUR NXT TO ANOTHER NXT

T

dacal ™
=

Select the Bluetooth submenu
on the NXT's display,

4. (P —

7

"

]
’
|

S - e =
& — |
' H I--III I--III
- : _-'I‘ . | —
Select the Search icon to search for lepending on how many devices are
other Bluetooth devices. Your NAT will defected in the area, a list will popup on
automatically search for Bluetooth the NXT's display after a few seconds,
tevices.

5. [FP——— |

' y |E Ll 9 y |E el b
awi M awsc aEs |
] F/ - / s /
Select the device you want fo connect tfo. Gelect which of the three lines of communication you want the connection to
Remember that you can give each NXT a he on |1, 2 or 3. You can connect yvour NXT to three different devices at the

unigue name

— see Naming the NXT on page 11.

T (F—— V|

5|

came time.

IFyou connect to a device For the Arst fime, your NXT will ask For
a passkey. Just press enter to use the default passkey 1234 or
make up your own code. The other Bluetooth device must know
your passkey in arder to confirm the connection. This means
that the fwo NXTs need o to enter the same pasckey in order to
connect.

IFyou want to connect your NXT o more than one Bluetooth
device, go to the My Contacts submenu to select a trusted contact
or start a new search.
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Connecting to more than one NXT

You can connect up to three NXTs ar other Bluetooth
devices to your NXT at the same time. However, you can
only communicate with one device at a time,

Sending Ales from NXT to NXT

It's easy to send programs from your NXT to another NXT:

'

T, pe———

L h— E— &

awas
[}

4

1 i ..

drtm—

Make sure that yvour NXT is connected to Select Send.

the NXT to which you want to send the
program [see page 3k, Lonnecting your
NXT to another NXT].

Gelect the My Files submenu in the NXT's
display and select the program you want
fo send.

or 3].
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Your NXT will now send the fle.
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Select which of the connected devices you
want the program to be sent to [Line 1, £
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Connecting your NXT to a mobile phone
IFyou have a mohile phone with Bluetooth capability,
you can use it with your LEGO® MINDSTORMS® NXT set.
o to www.MINOSTORMS.com/bluetooth For more infor-
mation on mohile phone requirements. Here you can also
download the MINDSTORMS NXT Eluetooth connection
program for your mobile phone and get additional infor-
mation on how to connect your NXT fo mobile phones.
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SYSTEM REQUIREMENTS

Before installing the LEGO® MINDSTORMS® NXT Software,
you must make sure that your computer meets the

Following minimum system requirements:

Windows

« |ntel® Pentium® processor or compatible,
a00 MHz minimum

» Windows XP Professional or Home Edition
with Service Pack ¢

« ¢56MB of RAM minimum

« lpto 300ME of available hard disk space

« XGA display [1024x768]

« 1availahle USE port

« [O-ROM drive

» Lompatible Bluetooth adapter [optional]*

FOWERED BY

/

)

Macintosh

» PowerP(® B3, G4, G5 processor, 600 MHz minimum
« Apple MacO5Xv. 10.3.9 0r 10.4

« ¢56MB of RAM minimum

 lpto 300ME of available hard disk space

« XBA display [1024x768]

« 1available USE port

« [O-ROM drive

» [Lompatihle Bluetooth adapter [optional|*

*Supparted Bluetooth software include Widcomm® Bluetooth for Windows [newer thanv, 1.4.2.10 SP5], and the Bluetooth stacks included
in Microsoft Windows XP [with Service Pack 2| and Apple Mac05 X [10.3.9 and 10.4]. For more details on compatible Bluetooth adapters,

see wWwwWw MINOSTORMS.com/bluetooth.

INSTALLING THE SOFTWARE

5|

Microsoft Windows

Exit all open programs.

Insert the CO-ROM.

IF the CO-ROM does not run automatically:

- click the Start button |at the bottom left-hand

corner of your screen|
- click Run

- type d\autorun.exe |where d: is your L0 drive]
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Select your preferred language.
‘ Follow the on-screen instructions.

LEGO® MINDESTORMS® MRT
Saftware v1.0

Mederlands

English

Francais

Deutsch
B
Exit

mindsTorms

Apple Macintosh

Exit all open programs.
Insert the CO-ROM.

Open the "LEGO MINOSTORMS NXT" CO-ROM and double-click Install.
Select your preferred language.
Follow the on-screen instructions.

When the installation procedure is complete, click Finish. You are now ready fo use the
LEGO MINDSTORMS NXT Software and create programs for cool robotic inventfions.

39




_J SOFTWARE

YOUR FIRST PROGRAM

E

This simple program will make the NXT play a
sound fle. It will help you understand how to
connect your computer to the NXT.

[7]

|
I
|
MINESTORNS ‘
(AT |

Start the software on your PL or Macintosh
by double-clicking the program icon.

Type in the name of your first program,
or just click on Go!

Start Mew Program

II"-'1'5,r Firsk Program I Go === \

Open Recent Progr am

I g Go > \

('

) First, click on the Sound block icon in
‘ the programming palette.

@|/CIO)
g .
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T Urag a Sound block and drop it to the right of the
R — Starting point in the work area.
Your program is now ready to download and run.

Make sure you furn on your NXT and connect the LISB
cable fo hoth your computer and the NXT |see page 8,
Lonnecting the NXT technology].

Locate the Controller in the lower right corner of the
work area. Llick Download and run [the central but-
fon] and listen to what happens.

Longratulations, you have completed your frst
— program!
{Download and run|

) %
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SOFTWARE USER INTERFACE

A quick overview

1. Robo Center
¢. My Portal
3. Tool bar

4. Work area O | | [
5. Little help window 2 = o
b. Work area map i s T -_:
. Programming palette aF 7=
8. Lonfguration panel I 4 —lj
9. Lontroller e -

L . ] e} I P - m s ke
H

I -i# i e e e g - : = B '.d-l'\--.|.:.:a-r|.|.a.-|:::-.:-::.-:.-| s e, Pk e
10. NXT window l&;g%,._q_ it e e L2 S

'Q LEGO MINDSTORMS HXT
Hie Edt Taok Help

—

Robo Center

* Quickscarn

el S

Move Block

Uze thiz blodk to zet your robobto go forkards or backwards
Im & straight line oF ta b by fallowing 3 curve. Define Row
tar wour rabot will go by uaing the Duration properes,

&PEIH:: Oa ®e @Mc i Pawer: ) —— ) E
g Ly Do Gomp O4m O n = Curstiors | 1) [Rowios (-]
' (o [ moatacton ol Brae O BS Cemm
by
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L

Robo Center window
Here you can And building and programming instructions for four cool models.

My Portal
Here you can access www. MINOSTORMS.com while programming your robots.
You can get more robotic challenges and download programs, sound effects and other cool stuff,

3 -

The tool bar
The tool har includes the most frequently used commands from the menu bar in an easy-to-reach
location.

H

The work area
This is the space on the screen where programming takes place. Drag programming blocks From the
programming palette to the work area and attach the hlocks to the sequence heam.

H

Little help window
Here you can always get help if needed.

The work area map
Lise the pan tool on the tool har to move around the work area — and use the work area map [tah in the
lower right corner| to get an overview.

& [

The programming palette

The programming palette contains all of the programming blocks you will need to create your
programs. The tahs at the bottom of the palette let you switch between the common palette |containing
the most frequently used hlocks|, the complete palette [containing all of the blocks|, and the custom
palette [containing hlocks that you download or create yourself].

.

The confguration panel
Each programming block has a confguration panel that lets you customize the block for the specific

input and output that you want.

The Controller
The fve buttons on the Controller let you download programs |or parts of programs] from your
computer o the NXT. With the Controller you can also change the settings of your NXT.

The NXT window
This pop-up window will give you information about your NXT's memory and communications settings.
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THE ROBO CENTER

e 1 In the Robo Center you will Aind different robot models

E

Robo Center

Vehicloas

* Qumickstart

O

Machinos "-,:' E

Animals

m Hame: = Yehides

Robo Center

E vehices
* Qmickstart

=
TriBOL * Stark hoeot
O ¢ !H :: j 2

=

Cam you build the robot o that it drives in the exact directions vou wanty

Toull need to bulld & tough driving base that can oo forwends, backwsards,
tum Eft, nght or stop.

Start

Programming Guide ih

that you can build and program fo do what you want.

Start by selecting a robot model to build and program.
we recommend that vou start with the TriBot as it is a

cantinuation of the Quick Start model included in the hox.

Follow the on-screen building and programming
instructions — or solve the challenge on your own.
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4) Building Guide

D rogrammirng Guicde

an pou program yor kabot o go Formards on the best pad and Hhen
reverse back to He starting poirk at a fasker speed?

. e
a/@ T o)
O b2 9

download it to the NXT and run if.

downloading a program.

Downloadf—

Testyour robot using the challenges provided.

The pragramming palette contains all of the programming
hlocks you will need to create your programs. Each
programming block determines how your robot acts or
reacts. By combining hlocks in sequence, you can create
programs that will make your robot come tfo life.

When you have Anished creating your program,

Hemember to turn on and connect yvour NXT before
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e

%,

o & =

Common palette

we recommend that yvou to start with the blocks in the
common palette. You should be able to finish all of the
starter challenges in the Robo Center with just these blocks.
The software's help area has more information ahout the rest
of the programming blocks when you are ready to move on.

T

E

s =
s

|
=-

Move block

This block controls the robot's motors and
synchronizes its movements. Use this block to
setyour robaf to go forwards or backwards in
a straight line or fo turn hy following a curve,

Record/Play hlock

This block lets you record a physical
movement with your robot and then play back
the recorded movement elsewhere in the
program.

Sound hlock

Lse this block fo play a sound Rle orasingle
fone. To compaose a melady of fones, arrange
several sound hlocks in @ row.

Display block

Use this block ta display an image, write some
text, or draw a shape on the NXT's display
SCreen.

To simplify its use, the programming palette has heen
divided info three palette groupings: the commaon
palefte [confaining the most used blocks|, the
complete palette [confaining all of the programming
blocks|, and the custom palette [containing blocks you
download or create yourself].

Wait block

This block lets your robot sense its environment
fora specifc condition before it confinues with the
program. For example, use the Wait block to make
the robot wait for a specific sound, fouch or time,
hefore it moves on with the program.

Loop block

Use thic block if you want your robot to do the
same thing again and again. For example, make
vour robot move Forwards and hackwards
continuously until the Touch Sensor is pressed,

Switch block

This block lets yvour robot make its own decisions,
such as going left when it hears a loud noise and
going right when it hears a soffer noise.
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THE CONFIGURATION PANEL

Each programming block has a configuration panel that lets you adjust the
settings of the block for the specificactions that you want. When a block

s selected in the work area, its configuration panel will be visible at the
bottom of the screen.

By changing the parameters on each configuration panel, you can change
how a particular block will behave. For example, to make your robot move
Faster, you can change the Power property on the Move block's configuration
panel.

S e— e

o we . ﬂ__:-; Port | B o ) Power; :___J-_| F,»,— !!_L_J
_.,_-h-'."
‘:;‘E,f s vy Direction: Domp O 4w O F¥ Duration: | 1 | [Ec-tati-:.ns @I
E
| L ? {:E;I =heeting: m’ !E‘-_Ir' Mext dctioni (s F‘IJ Brake () E-b Coast
| 0 B i |
| 0 & L/ A .

THE CONTROLLER

The Ave buttons on the Confroller communicate from your computer to the NXT:

The NXT window hutfon gives you access
to the NXT's memory and communications
J settings.

-

The Download and run selected button

downloads and runs just a piece of your

program’s code |e.q. a single hlock or just

a few hlocks|. Select the blocks you want

to testand click on the Download and run

selected button. You will then be able to see
=) how the small sequence of your program

performs on the NXT without having fo

download the whole program.

|
=l

The Download button downloads the program
to the NXT. You can then run the program
From the NXT.

The Download and run button
downloads a program to the
NXT and then starts running the
program.

=) The Stop button stops a running program.
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B LEGO® BRICKS

ELEMENT OVERVIEW

These are the LEGD® hricks in the MINOSTORMS® NXT set #8527,
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& LEGO® BRICKS

TEST PAD

Test all your models on this fest pad.

TESTPAD & BSZ7 g

==l This is the starting point on the pad.



B LEGO® BRICKS

LABELS

lise these labels to decorate your robots.

i

8
=
:EE
155
7 LI
L
1.
1@

.

You can use these lahels to stick around
both ends of a cahle, to make sure the
cable is connected to the right port.
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B USEFUL INFORMATION

TROUBLESHOOTING

Resetting the NXT

IF the running icon stops spinning, your NXT has frozen

and you will need to reset it. Follow these steps to reset your NXT:

Make sure that your NXT is furned on.

Push the reset hutton that is located on the hack of
vour NXT in the LEGD® Technic hole in the upper left
corner. Use, for example, an unfolded paperclip to

press the button.
IFyou press the reset button for more than 4 seconds

vou will need to update the Armware [see below].

Updating the Armware in the NXT From your computer

bo to Tools = Update NXT Firmware.

[El LEGO MINDSTORMS NXT
File Edit Tealk Help

B @- Calibrate Sensors % 'ﬂrl c;?

 Updats MXT Frmware... L
Common !n I My Progran

E

Make sure that your NXT is furned on.

Note! If you have just reset your NXT [see above|

the display will not show anything. A ticking sound
will tell whether it is furned on or not.

Make sure that your NXT and computer are connected
with the LISB cahle.

Go to the Tools pull-down menu in the software's
menu har and select Update NXT Firmware.



B USEFUL INFORMATION

) Update NCT Farmmeare . jm 5?|EET the Armware you wan’rl to update.
ST T T P Click download. [Note! The Windows "Found new
P et Ly —— hardware wizard' will pop up the Arst fime you
ﬂ T | update your Armware. Lomplete the wizard by
D R SRS RE 5 fhines Following the on-screen instruction before you

continuel.

Lack [ni SAProgram FlesLESC Safhu sl G0

WIMDETORME R Tergina FHTss _ haks
et g
+  FFmmarm _ﬁ—. Dacaaniboad
Pragross Bavirload selacted RET frmviara
Lacating HHT FrupaHrg HET Cawinkiad anoics
| Closa
|
| il 1

For ather types of troubleshooting, go fo www. MINOSTORMS.com/support

FCC approval:
Model: MINDSTORMS NXT  FCC10:NPI53788

This device complies with part 15 of the FCC Rules.
Operation is subject fo the following £ conditions:

1. This device may not cause harmful interference.
¢. This device must accept any interference received including interference that may cause undesired operation.

Warning:
Changes ar modifcations fo this unit not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

MOTE:

This equipment has heen tested and found fo comply with the limits for a Class B digital device, pursuant to part 15 of the FLL Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses an can radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful inferference to radio communications. However there is no quarantee that interference will not occurin a particular

installation. IFthis equipment does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off an on, the user is encouraged to try to correct the interference by ane or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation hetween the equipment and receiver.
- Lonnect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Lonsult the dealer or an experienced radio/TV technician For help.

To maintain the compliance with the FLL's RF exposure quideline, place the base unit at least 20 cm from nearby persons.
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Quick Build
schnellbaumodelle
Construction rapide
Costruzione rapida
snel bouwen
Construccion rapida
Byg hurtigt

MNopeaan rakentamiseen
Bygg snablbt
Construcao Rapida
rpfiyopeg Kataowkeués
Kiserletezdknelk

Experienced Build
Kénnermodelle
Construction normale
Costruzicone esperta
Bouwen voor gevorderden
Construccion experta

Byg videre

Kokeneelle rakentajalle
Eygg mer

Construcao para Experimentados
Emdétiee Kataoxzuio
Haladdknak

EmndsTorms

Advanced Build
Profimodelle
Construction avancee
Costruzione avanzata
Geavanceerd bouwen
Construccion avanzada

Byg avanceret
Taitavalle rakentajalle
Byag avancerat
Construcao Avancada
EEeAlylbves KaTaoxsus
Profiknak

BLUETODOTH is a trademark owned by Bluetooth S16, Inc. and licensed o the LEGD Group.
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£2007 The LEGO Group. 4520736-U5

Other prochuct and ompary names listed are trademarks or tracde names of their respective ompani es




